HP 520 Notebook PC

Maintenance and Service Guide



© Copyright 2007 Hewlett-Packard
Development Company, L.P.

Bluetooth is a trademark owned by its
proprietor and used by Hewlett-Packard
Company under license. Intel, Core, and
Celeron are trademarks or registered
trademarks of Intel Corporation or its
subsidiaries in the United States and other
countries. Java is a U.S. trademark of Sun
Microsystems, Inc. Microsoft, Windows, and
Windows Vista are either trademarks or
registered frademarks of Microsoft
Corporation in the United States and/or other
countries.

The information contained herein is subject to
change without notice. The only warranties
for HP products and services are set forth in
the express warranty statements
accompanying such products and services.
Nothing herein should be construed as
constituting an additional warranty. HP shall
not be liable for technical or editorial errors
or omissions contained herein.

First Edition: April 2007

Document Part Number: 446950-001



Safety warning notice

A WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact
the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the AC
adapter comply with the user-accessible surface temperature limits defined by the International Standard
for Safety of Information Technology Equipment (IEC 60950).
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1  Product description

Category Description 940GML 940GML 945GML
system system system
board board with board with
without WLAN WLAN
wireless
local area
network
(WLAN)

Product Name HP 520 Notebook PC v v v

Processors e Intel® Core™ Duo T2300 (1.66-GHz) processor v

with 667-MHz front side bus (FSB), 2 MB of L2
cache, socketed
e Intel Core Duo T2300E (1.66-GHz) processor v
with 667-MHz FSB, 2 MB of L2 cache, socketed
e Intel Core Solo T1400 (1.83-GHz) processor v
667-MHz FSB, 2 MB of L2 cache, socketed
e Intel Core Solo T1300 (1.66-GHz) processor v
667-MHz FSB, 2 MB of L2 cache, socketed
e Intel Celeron® M 420M (1.60-GHz) processor Vv v
533-MHz FSB, 512 KB of L2 cache, socketed
e Intel Celeron M 410M (1.46-GHz) processor v v
533-MHz FSB, 512 KB of L2 cache, socketed
Chipsets e Northbridge: Intel 945GM v
e Northbridge: Intel 940GML v v
e  Southbridge: Intel ICH-7M 4 4 4
Graphics Unified Memory Architecture (UMA) — graphics v v v
subsystem shares memory resources with main system
memory
Panels e 14.1-inch, WXGA (16:10 aspect ratio) v v
BrightView with wireless antenna transceivers
and cables
e 14.1-inch, WXGA (16:10 aspect ratio) 4
BrightView without wireless antenna transceivers
and cables
Memory e  Two SODIMM slots v v v

Customer-accessible/upgradable
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Category

Description 940GML 940GML

system system
board board with
without WLAN
wireless

local area

network

(WLAN)

945GML
system
board with
WLAN

DDRII PC2-5300 (667-MHz)
Suppors the following configurations:

o 2048 MB total system memory (1024-MB x
2)

° 1536 MB total system memory (1024-MB +
512-MB)

o 1024 MB total system memory (1024-MB x
1, 512-MB x 2)

o 768 MB total system memory (512-MB +
256-MB)

> 512 MB total system memory (512-MB x 1,
256-MB x 2)

o 256 MB total system memory (256-MB x 1)

Hard drives

Supports all 9.5-mm, 2.5-inch hard drives v v
Parallel ATA

Supporis the following drives:

° 120-GB, 5400-rpm

o 80-GB, 5400-rpm

Optical drives
(fixed)

12.7-mm tray load v v
Parallel ATA

Fixed, no modular requirements (1 screw
removal)

Supports the following drives:

> DVDxRW and CD-RW Super-Multi Double-

Layer Combo Drive

° DVD/CD-RW Combo Drive

Diskette drive

Supports external USB drive only v v

Audio

Conexant CX20549 v v
Single speaker

Headphone and microphone jacks

Modem

Conexant CX20548-11 v v

Modem cable included

Ethernet

Intel 82562GT 4 4
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Category Description 940GML 940GML 945GML
system system system
board board with  board with
without WLAN WLAN
wireless
local area
network
(WLAN)

Wireless Integrated wireless options by way of WLAN v v

module:

e WILAN antfennae (2, configured in display
assembly)

e Intel 802.11a/b/g

e  Broadcom 802.11b/g

External media  One Type I/l PC Card slot, 16-bit PCMCIA and 32-bit Vv v v

card CardBus

Ports e 2pin AC jack v v v

e Audio-out (stereo microphone) jack

e  Audioin (stereo headphone) jack

e  RJ-11 modem jack

e RJ-45 Ethernet jack (includes link and activity LEDs
e USB 2.0 ports (2)

e  VGA port (Dsub 15-pin)

Docking No docking support v v v

Keyboard/ e  Keyboard with embedded numeric keypad v v v

pointing devices

e  TouchPad with 2 buttons and one-way scroll
Power o 4cell, 2.2-Ah, 32-Wh, Li-ion battery v v v
requirements
NOTE: The HP 520 Notebook PC does not
support Smart Battery technology.
e  65W AC adapter with localized cable plug
support (2-wire plug with ground pin, supports 2-
pin DC connector)
NOTE: The HP 520 Notebook PC does not
support Smart AC adapter technology.

Security Security cable slot v v v

Operating Preinstalled: v v v

system

e  Windows Vista™ Home Basic
e  Windows Vista Business 32
e  FreeDOS

Serviceability End-user replaceable parts:

e  AC adapter v v v
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Category Description 940GML 940GML 945GML
system system system
board board with board with
without WLAN WLAN
wireless
local area
network
(WLAN)

e  Battery (system) v 4 4
e  Hard drive v v v
e Memory module v v v
o  WILAN module v v

Chapter 1
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2 External component identification

Front components

Iltem Component Function

(1) Wireless antennae (select models only) Send and receive signals from one or more wireless devices. These
antennae are not visible from the outside of the computer.

NOTE: To see wireless regulatory notices, refer to the section of
the Regulatory, Safety and Environmental Notices that applies to
your country or region. These notices are located in Help and
Support.

(2) Battery light e Amber: A battery is charging.
e  Green: A battery is close to full charge capacity.

e  Blinking amber: A battery that is the only available power
source has reached a low battery level. When the battery
reaches a critical battery level, the battery light begins to blink
rapidly.

e  Off: If the computer is plugged into an external power source,
the light turns off when all batteries in the computer are fully
charged. If the computer is not plugged info an external power
source, the light stays off until the battery reaches a low battery
level.

Front components 5



Iltem Component

Function

(3) Audio-out (headphone) jack

Produces sound when connected to optional stereo speakers,
headphones, ear buds, a headset, or television audio.

(4) Audio-in (microphone) jack

Connecls an optional computer headset microphone, stereo array
microphone, or monaural microphone.

Top components

Buttons and lights

Item Component

Function

(1) Caps lock light

On: Caps lock is on.

(2) Internal display switch

Turns off the display if the display is closed while the power is on.

(3) Wireless button (select models only)

Turns the wireless feature on or off, but does not create a wireless
connection.

NOTE: A wireless network must be set up in order to establish a
wireless connection.

(4) Wireless light (select models only)

e  On: An integrated wireless device, such as a wireless local
area network (WLAN) device, the HP Broadband Wireless
Module, and.or a Bluetooth® device, is on.

o  Off: All wireless devices are turned off.

(5) Power button*

e When the computer is off, press the button to turn on the
computer.

e When the computer is on, press the button to initiate the Sleep
state.
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Item Component Function
e When the computer is in the Sleep state, press the button briefly
to exit the Sleep state.
e When the computer is in Hibernation, press the button briefly
to exit Hibernation.
If the computer has stopped responding and Windows shutdown
procedures cannot be used, press and hold the power button for at
least 5 seconds fo turn off the computer.
To learn more about your power settings, select Start > Control
Panel > System and Maintenance > Power Options.
(6) Power light e  On: The computer is on.
e Blinking: The computer is in the Sleep state.
e  Blinking rapidly: An AC adapter with a higher power rating
should be connected.
e  Off: The computer is off or in Hibernation.
(7) Speaker Produces sound.

*This table describes factory settings. For information about changing factory settings, refer to the user guides in Help and Support.

Keys

Iltem Component Function

(1) esc key Displays system information when pressed in combination with the
fn key.

(2) fn key Executes frequently used system functions when pressed in
combination with a function key or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.
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Iltem Component Function

(5) Embedded numeric keypad keys Can be used like the keys on an external numeric keypad.

(6) Function keys Execute frequently used system functions when pressed in
combination with the fn key.

Pointing devices

|

EarEaTEATREATES
BB RS AN
mrrmsrEmrEseEaeEn

Iltem Component Function

(1) TouchPad* Moves the pointer and selects or activates items on the screen.
(2) Left TouchPad button* Functions like the left button on an external mouse.

(3) Right TouchPad button* Functions like the right button on an external mouse.

(4) TouchPad scroll zone* Scrolls up or down.

*This table describes factory settings. To view or change pointing device preferences, select Start > Control Panel >
Hardware and Sound > Mouse.
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Right-side components

Iltem Component Function
(1) Optical drive Reads an optical disc.
(2) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent, but it
may not prevent the computer from being mishandled or stolen.

Left-side components

o

Iltem Component Function

(1) Vent Enables airflow fo cool internal components.
NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal fan
to cycle on and off during routine operation.

(2) RJ-11 (modem) jack (select models only) Connects a modem cable.

(3) RJ-45 (network) jack Connects a network cable.

(4) Power connector Connects an AC adapter.
NOTE: The HP 520 Notebook PC does not support Smart AC
adapter technology.

(5) External monitor port Connects an optional VGA external monitor or projector.

(6) PC Card slot Supports optional Type | or Type Il 32-bit (CardBus) or 16-bit PC
Cards.

(7) USB ports (2) Connect an optional USB device.

(8) PC Card eject button Ejects the PC Card from the PC Card slot.

Right-side components 9



Bottom components

Item Component Function

(1) Battery bay Holds the battery.
NOTE: The HP 520 Notebook PC does not support Smart Battery
technology.

(2) Battery release latches (2) Release the battery from the battery bay.

(3) Hard drive bay Holds the hard drive.

(4) Vent Enables airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal fan
to cycle on and off during routine operation.

(5) Memory/WLAN module compartment Contains the memory module slot.

CAUTION: To prevent an unresponsive system, replace the
wireless module only with a wireless module authorized for use in
the computer by the governmental agency that regulates wireless
devices in your country or region. If you replace the module and then
receive a warning message, remove the module to restore computer
functionality, and then contact technical support through Help and
Support.
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3 lllustrated parts catalog

Serial number location

When ordering parts or requesting information, provide the computer serial number and model number
located on the bottom of the computer.

Serial number location 11



Computer major components

Item Description Spare part number

(1) Display assemblies

14.1-inch, WXGA BrightView display assembly for use only with computer models with ~ 448328-001
wireless LAN capability (includes wireless antenna transceivers and cables)
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Item Description Spare part number

14.1-inch, WXGA BrightView display assembly for use only with computer models without 448327-001
wireless LAN capability

(2) Switch covers

For use only with computer models with wireless LAN capability (includes wireless button  438561-001
and wireless light)

For use only with computer models without wireless LAN capability 438560-001
(3) Keyboards
Brazil 438531-201
The Czech Republic 438531-221
The Netherlands and Europe 438531021
France 438531051
Greece 438231-151
Hungary 438231-211
Israel 438531-BB1
Japan 438531-291
Korea 438531-AD1
Latin America 438231-161
Poland 438231-241
Russia 438231-251
Saudi Arabia 438231-171
Slovakia 438231-231
Slovenia 438231-BA1
South Africa 438231-AR1
Thailand 438231-281
Turkey 438231-141
The United Kingdom 438231031
The United States 438231001
(4) Top cover (includes TouchPad and TouchPad cable) 438522001
TouchPad cable (not illustrated) 438562001
(5) PC Card slot bezel 438527001
(6) PC Card assembly 438551001
(7) RTC battery 438556001
(8) Speaker 438559001
Plastics/Hardware Kit 448341-001
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Item Description Spare part number
(9a) Memory/WLAN module compartment cover (includes 1 captive screw, secured by a C
clip)
(9b) Hard drive cover (includes 2 captive screws, secured by C clips)
(10) Heat sink (includes thermal material) 448336-001
(11) System boards
For use only with computer models with Intel Core processors and WLAN capability 448339001
For use only with computer models with Intel Celeron M processors and WLAN capability 448337-001
For use only with computer models without WLAN capability 448338-001
(12) Processors (include thermal material)
Intel Core Solo T1400 1.83-GHz processor 448326-001
Intel Core Solo T1300 1.66-GHz processor 448325-001
Intel Core Duo T2300E 1.66-GHz processor 448324-001
Intel Core Duo T2300 1.66-GHz processor 448323-001
Intel Celeron M 420 1.60-GHz processor 448322001
Intel Celeron M 410 1.46-GHz processor 448321-001
(13) Fan assembly 438528-001
(14) 4-cell, 2.2-Ah, 32-Wh Battery 438518-001
(15) Base enclosure (includes 6 rubber feet, not illustrated) 438517-001
Rubber Feet Kit (includes 6 rubber feet, not illustrated) 438557-001
(16) Optical drives (include bezel and optical drive bracket)
DVD+RW and CD-RW Super-Multi Double-Layer Combo Drive 438523-001
DVD/CD-RW Combo Drive 438524-001
17) WLAN modules
802.11a/b/g WLAN modules:
e  For use in Antigua and Barbuda, Argentina, Australia, the Bahamas, Barbados, 407576-001
Brunei, Canada, Chile, the Dominican Republic, Guam, Guatemala, Hong Kong,
India, Indonesia, Malaysia, Mexico, New Zealand, Panama, Paraguay, Saudi
Arabia, Taiwan, the United States, and Vietnam
e  Foruse in Aruba, Austria, Azerbaijan, Bahrain, Belgium, Bermuda, Brazil, Bulgaria, 407576-002
the Cayman Islands, Colombia, Croatia, Cyprus, the Czech Republic, Denmark,
Egypt, El Salvador, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, ltaly, Jordan, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg,
Malta, Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal,
Romania, Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South
Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey, the United Kingdom, and
Uzbekistan
e  For use in Ecuador, Haiti, Honduras, Pakistan, the People's Republic of China, Peru, 407576-003
Qatar, South Korea, Uruguay, and Venezuela
e  Forusein Japan 407576-291

802.11b/g WLAN modules:
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Item Description Spare part number
e  For use in Canada and the United States 407107-001
e  For use in Algeria, Andorra, Argentina, Australia, Austria, Bahrain, Bangladesh, 407107-002
Belarus, Belgium, Bolivia, Brazil, Brunei, Bulgaria, Chile, Colombia, Costa Rica,
Croatia, Cyprus, Czech Republic, Denmark, Ecuador, Egypt, El Salvador, Estonia,
Finland, France, Germany, Gibraltar, Greece, Guatemala, Honduras, Hong Kong,
Hungary, Iceland, India, Indonesia, Ireland, Israel, ltaly, Jordan, Kuwait, Latvia,
Lebanon, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Malaysia,
Mexico, Morocco, Netherlands, New Zealand, Nicaragua, Norway, Oman,
Pakistan, Panama, Paraguay, People's Republic of China, Peru, Philippines, Poland,
Portugal, Qatar, Romania, Russia, Saudi Arabia, Singapore, Slovakia, Slovenia,
South Africa, South Korea, Spain, Sri Lanka, Sweden, Switzerland, Taiwan,
Thailand, Tunisia, Turkey, Ukraine, United Arab Emirates, United Kingdom, Uruguay,
Venezuela, Vietnam, and Yemen
e  For use in Japan 407107-291
(18) Memory modules (667-MHz, PC2-5300, 1-DIMM
For use in all countries or regions except Brazil:
° 1024-MB 409060-001
e 512-MB 447518-001
e 256-MB 447517-001
For use only in Brazil:
° 1024-MB 448329-001
e 512-MB 448331-001
e 256-MB 448330-001
(19) Hard drives (include hard drive bracket and connector)
120 GB, 5400-rpm 435775-001
80 GB, 5400-rpm 435773-001

Computer major components
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Display assembly components

Item Description Spare part number
(1) Display bezel 438535-001

(2) Display Bracket/Hinge Kit 448335001

(3) 14.1-inch, WXGA, BrightView display panel 448333-001

(4) Display inverter 448332001

(5) Wireless Antenna Kit (includes transceivers and cables) 438516001

(6) Display enclosures

For use only with computer models with wireless LAN capability (includes logo and wireless  438539-001
antenna transceivers and cables)

For use only with computer models without wireless LAN capability (includes logo) 438538-001
Display Cable Kit (not illustrated) 448334-001
Display Label Kit (not illustrated) 448340001
Display Screw Kit (not illustrated) 438543-001
Display Screw Cover Kit (not illustrated) 438542-001
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Plastics/Hardware Kit

Item Description Spare part number
Plastics/Hardware Kit 448341001

(1) Hard drive cover (includes 2 captive screws, secured by C clips)

(2) Memory/WLAN module compartment cover (includes 1 captive screw, secured by a C

clip)

Plastics/Hardware Kit
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Mass storage devices

Item Description Spare part number
(1) Hard drives (include frame and connector)
120-GB, 5400-rpm 435775001
80-GB, 5400-rpm 435773-001
(2) Optical drives (include bezel and bracket)
DVD+RW and CDRW Super-Multi, Double-Layer Combo Drive 438523001
DVD/CD-RW Combo Drive 438524-001
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Miscellaneous parts

Description Spare part number

65-watt AC adapter 417220-001

Power cords:

Australia 350055-011
Brazil 350055-201
Denmark 350055-081
Europe 350055-021
French Canada 350055-DB1
Israel 350055-BB1
laly 350055061
Japan 350055-291
Korea 350055-AD1
People's Republic of China 350055-AA1
Switzerland 350055-BG1
The United Kingdom 350055-031
The United States 350055-001
Screw Kit 438558-001

e  Phillips PM3.0x3.0 screw
o Phillips PM2.5x8.0 capfive screw
o Phillips PM2.5x6.0 screw
e  Phillips PM2.0x9.0 screw

e  Phillips PM2.0x3.0 screw
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Sequential part number listing

Spare part Description

number

350055-001 Power cord use in the United States

350055-011 Power cord for use in Australia

350055-021 Power cord for use in Europe

350055-031 Power cord for use in the United Kingdom

350055-061 Power cord for use in ltaly

350055-081 Power cord for use in Denmark

350055-201 Power cord for use in Brazil

350055-291 Power cord for use in Japan

350055-AA1 Power cord for use in the People’s Republic of China

350055-AD1 Power cord for use in Korea

350055-BB1 Power cord for use in Israel

350055-BG1 Power cord for use in Switzerland

350055-DB1 Power cord for use in French Canada

407107-001 802.11b/g WLAN module for use in Canada and the United States

407107-002 802.11b/g WLAN module for use in Algeria, Andorra, Argentina, Australia, Austria, Bahrain,
Bangladesh, Belarus, Belgium, Bolivia, Brazil, Brunei, Bulgaria, Chile, Colombia, Costa Rica, Croatia,
Cyprus, Czech Republic, Denmark, Ecuador, Egypt, El Salvador, Estonia, Finland, France, Germany,
Gibraltar, Greece, Guatemala, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel,
ltaly, Jordan, Kuwait, Latvia, Lebanon, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Malaysia, Mexico, Morocco, Netherlands, New Zealand, Nicaragua, Norway, Oman, Pakistan,
Panama, Paraguay, People's Republic of China, Peru, Philippines, Poland, Portugal, Qatar, Romania,
Russia, Saudi Arabia, Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain, Sri Lanka,
Sweden, Switzerland, Taiwan, Thailand, Tunisia, Turkey, Ukraine, United Arab Emirates, United Kingdom,
Uruguay, Venezuela, Vietnam, and Yemen

407107-291 802.11b/g WLAN module for use in Japan

407576001 802.11a/b/g WLAN module for use in Antigua and Barbuda, Argentina, Australia, the Bahamas,
Barbados, Brunei, Canada, Chile, the Dominican Republic, Guam, Guatemala, Hong Kong, India,
Indonesia, Malaysia, Mexico, New Zealand, Panama, Paraguay, Saudi Arabia, Taiwan, the United
States, and Vietnam

407576-002 802.11a/b/g WLAN module for use in Aruba, Austria, Azerbaijan, Bahrain, Belgium, Bermuda, Brazil,
Bulgaria, the Cayman Islands, Colombia, Croatia, Cyprus, the Czech Republic, Denmark, Egypt, El
Salvador, Estonia, Finland, France, Georgia, Germany, Greece, Hungary, Iceland, Ireland, Italy, Jordan,
Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco, the Netherlands, Norway, Oman,
the Philippines, Poland, Portugal, Romania, Russia, Serbia and Montenegro, Singapore, Slovakia,
Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey, the United Kingdom, and
Uzbekistan

407576-003 802.11a/b/g WLAN module for use in Ecuador, Haiti, Honduras, Pakistan, the People's Republic of
China, Peru, Qatar, South Korea, Uruguay, and Venezuela

407576-291 802.11a/b/g WLAN module for use in Japan

409060-001 1024-MB, 667-MHz, PC2-5300, 1-DIMM memory module for use in all countries and regions except

Brazil
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Spare part Description

number

417220-001 65-watt AC adapter

435773001 80-GB, 5400-rpm hard drive (includes hard drive bracket and connector)
435775001 120-GB, 5400-rpm hard drive (includes hard drive bracket and connector)
438516001 Wireless Antenna Kit (includes wireless antenna transceivers and cables)
438517-001 Base enclosure (includes 6 rubber feet)

438518-001 4-cell, 2.2-Ah, 32-Wh Battery

438522-001 Top cover (includes TouchPad and TouchPad cable)

438523001 DVD+RW and CDRW Super-Multi Double-Layer Combo Drive (includes bezel and optical drive bracket)
438524001 DVD/CD-RW Combo Drive (includes bezel and optical drive bracket)
438527-001 PC Card slot bezel

438528-001 Fan assembly

438531001 Keyboard for use in the United States

438531021 Keyboard for use in the Netherlands and Europe

438531-031 Keyboard for use in the United Kingdom

438531051 Keyboard for use in France

438531-141 Keyboard for use in Turkey

438531-151 Keyboard for use in Greece

438531-161 Keyboard for use in Latin America

438531-171 Keyboard for use in Saudi Arabia

438531-201 Keyboard for use in Brazil

438531-211 Keyboard for use in Hungary

438531-221 Keyboard for use in the Czech Republic

438531-231 Keyboard for use in Slovakia

438531-241 Keyboard for use in Poland

438531-251 Keyboard for use in Russia

438531-281 Keyboard for use in Thailand

438531291 Keyboard for use in Japan

438531-AD1 Keyboard for use in Korea

438531-AR1 Keyboard for use in South Africa

438531-BA1 Keyboard for use in Slovenia

438531-BB1 Keyboard for use in Israel

438535-001 Display bezel

438538-001 Display enclosure for use only with computer models without wireless LAN capability (includes logo)

Sequential part number listing 21



Spare part Description

number

438539-001 Display enclosure for use only with computer models with wireless LAN capability (includes logo and
wireless antenna transceivers and cables)

438542001 Display Screw Cover Kit

438543-001 Display Screw Kit

438551-001 PC Card assembly

438556-001 RTC battery

438557-001 Rubber Feet Kit

438558-001 Screw Kit

438559001 Speaker

438560-001 Switch cover for use only with computer models without wireless LAN capability

438561-001 Switch cover for use only with computer models with wireless LAN capability (includes wireless button and
wireless light)

438562-001 TouchPad cable

447517001 512-MB, 667-MHz, PC2-5300, 1-DIMM memory module for use in all countries and regions except
Brazil

447518-001 256-MB, 667-MHz, PC2-5300, 1-DIMM memory module for use in all countries and regions except Brazil

448321-001 Intel Celeron M 410 1.46-GHz processor

448322001 Intel Celeron M 420 1.60-GHz processor

448323-001 Intel Core Duo 72300 1.66-GHz processor

448324-001 Intel Core Duo T2300E 1.66-GHz processor

448325-001 Intel Core Solo T1300 1.66-GHz processor

448326-001 Intel Core Solo T1400 1.83-GHz processor

448327-001 14.1-inch, WXGA BrightView display assembly for use only with computer models without wireless LAN
capability

448328-001 14.1-inch, WXGA BrightView display assembly for use only with computer models with WLAN capability
(includes wireless antenna transceivers and cables)

448329-001 1024-MB, 667-MHz, PC2-5300, 1-DIMM memory module for use only in Brazil

448330001 256-MB, 667-MHz, PC2-5300, 1-DIMM memory module for use only in Brazil

448331-001 512-MB, 667-MHz, PC2-5300, 1-DIMM memory module for use only in Brazil

448332-001 Display inverter

448333-001 14.1-inch, WXGA, BrightView display panel

448334-001 Display Cable Kit

448335-001 Display Bracket/Hinge Kit

448336-001 Heat sink (includes thermal material)

448337-001 For use only with computer models with Intel Celeron M processors and WLAN capability

448338-001 For use only with computer models without WLAN capability
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Spare part Description

number

448339001 For use only with computer models with Intel Core processors and WLAN capability
448340-001 Display Label Kit

448341-001 Plastics/Hardware Kit
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4 Removal and replacement
procedures

Preliminary replacement requirements

Tools required
You will need the following tools to complete the removal and replacement procedures:
e  Magnetic screwdriver
e  Phillips PO and P1 screwdrivers

o  Flatbladed screwdriver

Service considerations

The following sections include some of the considerations that you should keep in mind during disassembly
and assembly procedures.

B NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

Using excessive force during disassembly and reassembly can damage plastic parts. Use care when
handling the plastic parts. Apply pressure only at the points designated in the maintenance instructions.

Cables and connectors

A CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with extreme
care; these cables tear easily.
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Drive handling

A CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the computer
is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and be
sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.
Avoid exposing a drive fo temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive fo electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some protection,
but in many cases, ESD contains enough power to alter device parameters or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

A CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you area ready to install them.
Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described in
this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.
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/A CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

Relative humidity

Event 10% 40% 55%
Walking across carpet 35,000 V 15,000 V 7,500V
Walking across vinyl floor 12,000 V 5,000 V 3,000V
Motions of bench worker 6,000 V 800V 400V
Removing DIPS from plastic tube 2,000 vV 700V 400V
Removing DIPS from vinyl tray 11,500 V 4,000V 2,000V
Removing DIPS from Styrofoam 14,500 V 5,000V 3,500 V
Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V
Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V

Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.
Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

Place items on a grounded surface before removing items from their containers.

Always be properly grounded when touching a component or assembly.

Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive foam.

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that mechanized
equipment used for moving materials is wired fo ground and that proper materials are selected to
avoid static charging. When grounding is not possible, use an ionizer to dissipate electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

Cover the workstation with approved static-shielding material.

Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.
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Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle these
items only at static-free workstations.

Avoid contact with pins, leads, or circuitry.

Turn off power and input signals before inserting or removing connectors or test equipment.

Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm +10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps) can
be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one megohm
resistance between the operator and ground. To be effective, the conductive strips must be worn in
contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

Antistatic tape

Antistatic smocks, aprons, and sleeve protectors

Conductive bins and other assembly or soldering aids
Nonconductive foam

Conductive tabletop workstations with ground cords of one megohm resistance
Static-dissipative tables or floor mats with hard ties to the ground
Field service kits

Static awareness labels

Material-handling packages

Nonconductive plastic bags, tubes, or boxes

Metal tote boxes

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level
Antistatic plastic Bags 1,500 V
Carbon-loaded plastic Floor mats 7,500 V
Metallized laminate Floor mats 5,000V
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Unknown user password

If the computer you are servicing has an unknown user password, follow these steps to clear the password.

B NOTE: These steps also clear CMOS.

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 31).

5. Remove the realtime clock (RTC) battery (see RTC battery on page 52).

6. Wait approximately 5 minutes.

7. Replace the RTC battery and reassemble the computer.

8. Connect AC power to the computer. Do not reinsert any batteries at this time.
9. Turn on the computer.

All passwords and all CMOS settings have been cleared.

Preliminary replacement requirements 29



Component replacement procedures

This chapter provides removal and replacement procedures.

There are as many as 59 screws, in 7 different sizes, that must be removed, replaced, or loosened when
servicing the computer. Make special note of each screw and screw lock size and location during removal
and replacement.

Serial number

Report the computer serial number to HP when requesting information or ordering spare parts. The serial
number is located on the bottom of the computer.
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Battery

Description Spare part number

4-cell, 2.2-Ah, 32-Wh Battery 438518-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery:
1. Turn the computer upside down on a flat surface, with the rear panel toward you.

2. Slide the battery release latches (1) to release the battery.

3. Remove the battery (2).

Install the battery by inserting it into the battery bay until you hear a click.
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Hard drive

Description Spare part number
120-GB, 5400-rpm 435775-001
80-GB, 5400-rpm 435773-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 31).

Remove the hard drive:
1. Position the computer with the front toward you.
2. Lloosen the two Phillips PM2.5x8.0 screws (1) that secure the hard drive cover to the computer.

3. Lift the left side of the hard drive cover (2), swing it to right, and remove the cover. The hard drive
cover is included in the Plastics/Hardware Kit, spare part number 448341-001.

4. Grasp the Mylar tab (1) on the hard drive and slide the hard drive (2) to the left to disconnect it
from the system board.
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5. Remove the hard drive (3) from the hard drive bay.

6. If it is necessary fo replace the hard drive bracket, remove the four Phillips PM3.0x3.0 hard drive
bracket screws (1) from each side of the hard drive.

7.  Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.
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Computer feet

Description Spare part number

Rubber Feet Kit 438557-001

The computer feet are adhesive-backed rubber pads. There are 6 rubber feet. The feet attach to the base
enclosure in the locations illustrated below.

I S
T : '
| : '
I |
| |
|
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Memory module

Description Spare part number

For use in all countries and regions except Brazil

1024-MB, PC2-5300, 1-DIMM 409060-001
512-MB, PC2-5300, 1-DIMM 447518-001
256-MB, PC2-5300, 1-DIMM 447517001

For use only in Brazil

1024-MB, PC2-5300, 1-DIMM 448329001
512-MB, PC2-5300, 1-DIMM 448331001
256-MB, PC2-5300, 1-DIMM 448330001

Before removing the memory module, follow these steps:

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 31).

Remove the external memory module:

1.
2.

Position the computer with the rear panel toward you.

Loosen the Phillips PM2.5%8.0 screw (1) that secures the memory/WLAN module compartment
cover to the computer.

Lift the front edge of the cover (2), swing it toward you, and remove the cover. The memory/WLAN
module compartment cover is included in the Plastics/Hardware Kit, spare part number
448341-001.
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4. Spread the retaining tabs (1) on each side of the memory module slot to release the memory module.
(The edge of the module opposite the slot rises away from the computer.)

5. Remove the memory module (2) by pulling the module away from the slot at an angle.

Bf NOTE: Memory modules are designed with a notch (3) to prevent incorrect installation into the
memory module slot.

Reverse this procedure to install a memory module.
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WLAN module

Description

Spare part number

802.11a/b/g WLAN modules:

For use in Antigua and Barbuda, Argentina, Australia, the Bahamas, Barbados, Brunei, Canada,
Chile, the Dominican Republic, Guam, Guatemala, Hong Kong, India, Indonesia, Malaysia,
Mexico, New Zealand, Panama, Paraguay, Saudi Arabia, Taiwan, the United States, and
Vietnam

407576-001

For use in Aruba, Austria, Azerbaijan, Bahrain, Belgium, Bermuda, Brazil, Bulgaria, the Cayman
Islands, Colombia, Croatia, Cyprus, the Czech Republic, Denmark, Egypt, El Salvador, Estonia,
Finland, France, Georgia, Germany, Greece, Hungary, Iceland, Ireland, ltaly, Jordan, Latvia,
Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco, the Netherlands, Norway,
Oman, the Philippines, Poland, Portugal, Romania, Russia, Serbia and Montenegro, Singapore,
Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey, the United
Kingdom, and Uzbekistan

407576-002

For use in Ecuador, Haiti, Honduras, Pakistan, the People's Republic of Ching, Peru, Qatar, South
Korea, Uruguay, and Venezuela

407576003

For use in Japan

407576-291

802.11b/g WLAN modules:

For use in Canada and the United States

407107001

For use in For use in Algeria, Andorra, Argentina, Australia, Austria, Bahrain, Bangladesh,
Belarus, Belgium, Bolivia, Brazil, Brunei, Bulgaria, Chile, Colombia, Costa Rica, Croatia,
Cyprus, Czech Republic, Denmark, Ecuador, Egypt, El Salvador, Estonia, Finland, France,
Germany, Gibraltar, Greece, Guatemala, Honduras, Hong Kong, Hungary, Iceland, India,
Indonesia, Ireland, Israel, ltaly, Jordan, Kuwait, Latvia, Lebanon, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Malaysia, Mexico, Morocco, Netherlands, New Zealand, Nicaragua,
Norway, Oman, Pakistan, Panama, Paraguay, People's Republic of China, Peru, Philippines,
Poland, Portugal, Qatar, Romania, Russia, Saudi Arabia, Singapore, Slovakia, Slovenia, South
Africa, South Korea, Spain, Sri Lanka, Sweden, Switzerland, Taiwan, Thailand, Tunisia, Turkey,
Ukraine, United Arab Emirates, United Kingdom, Uruguay, Venezuela, Vietnam, and Yemen

407107-002

For use in Japan

407107-291

Before removing the WLAN module, follow these steps:

1.

2.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the

computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and

then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 31).

Remove the memory/WLAN module compartment cover (see Memory module on page 35).
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Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

Bf NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The
white WLAN antenna cable is connected to the WLAN module “Aux” terminal.

2. Remove the two Phillips PM2.0x4.0 screws (2) that secure the WLAN module to the computer. (The
edge of the module opposite the slot rises away from the computer.)

3.  Remove the WLAN module (3) by pulling the module away from the slot at an angle.

B NOTE: WLAN modules are designed with a notch (4) to prevent incorrect installation.

Reverse this procedure fo install a WLAN module.
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Optical drive

Ef NOTE: All optical drive spare part kits include an optical drive bezel and optical drive bracket.

Description Spare part number
DVD+RW and CD-RW Super-Multi Double-Layer Combo Drive 438523-001
DVD/CD-RW Combo Drive 438524001

Before removing the optical drive, follow these steps:

1.

4.

5.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 31).

Remove the memory/WLAN module compartment cover (see Memory module on page 35).

Remove the optical drive:

1.
2.

3.

4.

5.

Position the computer with left side toward you.
Remove the Phillips PM2.0x9.0 screw (1) that secures the optical drive to the computer.

Use a flat-bladed tool to push the metal tab (2) toward the left side of the computer. (The optical
drive partially removes from the optical drive bay.)

Remove the optical drive (3) from the computer.

If it is necessary to replace the optical drive bracket, remove the two Phillips PM2.0x3.0 screws
(1) that secure the bracket to the optical drive.
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6. Remove the optical drive bracket (2).

—
o

o %

Reverse this procedure to reassemble and install the optical drive.
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Switch cover

Description Spare part number

For use only with computer models with wireless LAN capability (includes wireless button and wireless 438561-001

light)

For use only with computer models without wireless LAN capability 438560-001

Before removing the switch cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 31).

Remove the switch cover:
1. Turn the computer upside down, with the rear panel toward you.

2. Remove the five Phillips PM2.0x9.0 screws that secure the switch cover to the computer.

I
I
I
I
I

3. Partially open the computer.
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4. Use a flat-bladed tool to gently pry the tabs on the switch cover out of the slots on the computer.

Turn the computer display-side up, with the front toward you.
Open the computer as far as possible.

Lift the rear edge of the switch cover and swing it forward.

L

Remove the switch cover.

Reverse this procedure fo install the switch cover.
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Keyboard

For use in: Spare part number  For use in: Spare part number
Brazil 438531-201 Poland 438531-241
The Czech Republic 438531-221 Russia 438531-251
The Netherlands and Europe 438531021 Saudi Arabia 438531171
France 438531-051 Slovakia 438531-231
Greece 438531-151 Slovenia 438531-BA1
Hungary 438531-211 South Africa 438531-AR1
Israel 438531-BB1 Thailand 438531-281
Japan 438531-291 Turkey 438531-141
Korea 438531-AD1 The United Kingdom 438531-031
Latin America 438531-161 The United States 438531-001

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the

computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 31).

5. Remove the memory/WLAN module compartment cover (see Memory module on page 35).

Remove the keyboard:

1. Position the computer with the front toward you.

2. Remove the two Phillips PM2.0x9.0 screws that secure the keyboard to the computer.

3. Turn the computer display-side up, with the front foward you.
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4. Open the computer as far as possible.

5. Lift the rear edge of the keyboard and swing it toward you until it rests on the palm rest.

6. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
disconnect the keyboard cable (2).

7. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Display assembly

Description Spare part number

14.1-inch, WXGA BrightView display assembly for use only with computer models with wireless LAN  448328-001
capability (includes wireless antenna transceivers and cables)

14.1-inch, WXGA BrightView display assembly for use only with computer models without wireless ~ 448327-001
LAN capability

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 31).

5. Remove the memory/WLAN module compartment cover (see Memory module on page 35) and
disconnect the wireless antenna cables from the WLAN module (see WLAN module on page 37).

6. Remove the following components:

a. Switch cover (see Switch cover on page 41)

b. Keyboard (see Keyboard on page 43)

Remove the display assembly:
1. Close the computer and turn it upside down, with the rear panel toward you.

2. Remove the two Phillips PM2.0x7.0 screws that secure the display assembly to the computer.

T
I
I
I
I

3. Turn the computer display-side up, with the front toward you.

4. Open the computer until the display assembly is in an upright position.
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5. Disconnect the display cable connector(1) from the system board and remove the display panel
cable (2) from the clips and routing channel built into the top cover.

6. Remove the wireless antenna cables (3) from the clips and routing channel built into the top cover.

7. Remove the two Phillips PM2.0x9.0 screws (4) that secure the display assembly to the computer.

8. Lift the display assembly straight up and remove it.
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9. Ifitis necessary to replace the display bezel or any of the display assembly internal subcomponents,
remove the following display bezel screw covers and screws:

(1) Four round rubber screw covers on the display bezel top edge. The display bezel screw covers
are available in the Display Screw Cover Kit, spare part number 438542-001. All screws used to

secure display assembly internal subcomponents are available in the Display Screw Kit, spare part
number 438543-001.

(2) Four flat rubber screw covers on the display bezel bottom edge.

(3) Eight Phillips PM2.5x6.0 screws.

°l
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10. Flex the inside edges of the top side (1), the left and right sides (2) of the display bezel, and the
bottom side (3) of the display bezel until the bezel disengages from the display assembly.

11. Remove the display bezel (4). The bezel is available using spare part number 438535-001.

12. Ifitis necessary to replace the display inverter, remove the Phillips PM2.5x6.0 screw (1) that secures
the inverter to the display enclosure.

13. Disconnect the display panel cable (2) and the backlight cable (3) from the inverter.
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14. Remove the display inverter (4). The inverter is available using spare part number 448332-001.

15. If it is necessary to replace the display panel, remove the four Phillips PM2.5x6.0 screws (1) that
secure the panel to the display enclosure.

16. Remove the display panel (2). The panel is available using spare part number 448333-001.

17. If it is necessary to replace either of the display hinges, remove the four Phillips PM2.0x3.0
screws (1) that secure each hinge to the display panel.
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18. Remove the display hinges (2). The hinges are available in the Display Bracket/Hinge Kit, spare
part number 448335-001.

19. If it is necessary to replace the wireless antenna transceivers (1) and cables (2), remove the
transceivers and cables from the display enclosure. The wireless antenna transceivers and cables are
available in the Wireless Antenna Kit, spare part number 438516-001.

B NOTE: The wireless antenna transceivers are attached to the display enclosure by a thin layer of
adhesive. It may be necessary to use a flat-bladed tool to pry the transceivers away from the display
enclosure.

. Y

Reverse this procedure to reassemble and install the display assembly.
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Base enclosure

Description Spare part number

Base enclosure 438517-001

Before removing the base enclosure, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 31).

5. Remove the following components:

a.
b.
c.
d.
e.

f.

Hard drive (see Hard drive on page 32)

Memory/WLAN module compartment cover (see Memory module on page 35)

Optical drive (see Optical drive on page 39)

Switch cover (see Switch cover on page 41)

Keyboard (see Keyboard on page 43)

Display assembly (see Display assembly on page 45)

Remove the base enclosure:

1. Release the ZIF connector (1) to which the TouchPad cable is attached, and disconnect the TouchPad
cable (2) from the system board.

2. Turn the computer upside down, with the front toward you.
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3. Remove the seven Phillips PM2.0x9.0 screws (1) and the two Phillips PM2.0x3.0 screws (2) that
secure the base enclosure to the computer.

4.  lift the left side of the base enclosure (1) until the USB connectors (2) disengage from their openings
in the base enclosure.

5. Remove the base enclosure.

Reverse this procedure to install the base enclosure.
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RTC battery

Ef NOTE: Removing the RTC battery and leaving it uninstalled for 5 or more minutes causes all passwords
and CMQOS settings to be cleared.

Description Spare part number

RTC battery 438556-001

Before removing the RTC battery, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 31).

Remove the following components:

a. Hard drive (see Hard drive on page 32)

b. Memory/WLAN module compartment cover (see Memory module on page 35)

c. Optical drive (see Optical drive on page 39)

d. Switch cover (see Switch cover on page 41)

e. Keyboard (see Keyboard on page 43)

f. Display assembly (see Display assembly on page 45)

g. Base enclosure (see Base enclosure on page 50)

Remove the RTC battery:

A Use a non-conductive, flat-bladed tool to pry the RTC battery out of the socket.
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Reverse this procedure to install the RTC battery. Be sure the RTC battery is installed with the “+” sign
facing up.

Fan assembly

Description Spare part number

Fan assembly 438528-001

Before removing the fan assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 31).

5. Remove the following components:

a. Hard drive (see Hard drive on page 32)

b. Memory/WLAN module compartment cover (see Memory module on page 35)

c. Optical drive (see Optical drive on page 39)

d. Switch cover (see Switch cover on page 41)

e. Keyboard (see Keyboard on page 43)

f. Display assembly (see Display assembly on page 45)

d. Base enclosure (see Base enclosure on page 50)

Remove the fan assembly:
1. Disconnect the fan cable (1) from the system board.

2.  Remove the Phillips PM2.0x9.0 screw (2) that secures the fan assembly to the top cover.
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3. Remove the fan assembly (3).

Reverse this procedure to install the fan assembly.

Ef NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the left and
right sides of the computer.

The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is
designed to be turned on automatically when high temperature conditions exist. These conditions are
affected by high external temperatures, system power consumption, power management/battery
conservation configurations, battery fast charging, and software applications. Exhaust air is displaced
through the ventilation grill located on the left side of the computer.
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Heat sink

Description Spare part number

Heat sink (includes thermal material) 448336-001

Before removing the heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 31).

5. Remove the following components:

a.

b.

g.
h.

Hard drive (see Hard drive on page 32)

Memory/WLAN module compartment cover (see Memory module on page 35)

Optical drive (see Optical drive on page 39)

Switch cover (see Switch cover on page 41)

Keyboard (see Keyboard on page 43)

Display assembly (see Display assembly on page 45)

Base enclosure (see Base enclosure on page 50)

Fan assembly (see Fan assembly on page 53)

Remove the heat sink:

1. Remove the four Phillips PM2.5x6.0 screws (1) that secure the heat sink to the system board.

2. Release the heat sink (2) by sliding it to the left until the right side of the heat sink clears the top
cover.

B’ NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
processor, it may be necessary to move the heat sink from side to side to detach the heat sink from
the processor.
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3. Lift the left side of the heat sink (3) and remove it.

B NOTE: The thermal material should be thoroughly cleaned from the surfaces of the video
processor (1), the processor (2), and the heat sink (3) and (4) each time the heat sink is removed.
Reapply the thermal material when the heat sink is replaced. Thermal material is included with all
heat sink, processor, and system board spare part kits.

Reverse this procedure to install the heat sink.
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Processor

Ef NOTE: All processor spare part kits include thermal material.

Description Spare part number
Intel Core Solo T1400 1.83-GHz processor 448326-001
Intel Core Solo T1300 1.66-GHz processor 448325-001
Intel Core Duo T2300E 1.66-GHz processor 448324-001
Intel Core Duo T2300 1.66-GHz processor 448323-001
Intel Celeron M 420 1.60-GHz processor 448322-001
Intel Celeron M 410 1.46-GHz processor 448321001

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the

computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and

then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 31).
5. Remove the following components:

a. Hard drive (see Hard drive on page 32)

b. Memory/WLAN module compartment cover (see Memory module on page 35)

c. Optical drive (see Optical drive on page 39)

d. Switch cover (see Switch cover on page 41)

e. Keyboard (see Keyboard on page 43)

f. Display assembly (see Display assembly on page 45)

g. Base enclosure (see Base enclosure on page 50)

h. Fan assembly (see Fan assembly on page 53)

i. Heat sink (see Heat sink on page 55)

Remove the processor:

1. Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn counterclockwise

until you hear a click.
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2.

Lift the processor (2) straight up and remove it.

B NOTE: The gold triangle (3) on the processor should be aligned with the triangle (4) embossed

on the processor socket when you install the processor.

Reverse this procedure fo install the processor.

Speaker

Description Spare part number

Speaker

438559001

Before removing the speaker, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 31).

Remove the following components:

a.

b.

Hard drive (see Hard drive on page 32)

Memory/WLAN module compartment cover (see Memory module on page 35)

Optical drive (see Optical drive on page 39)

Switch cover (see Switch cover on page 41)

Keyboard (see Keyboard on page 43)

Display assembly (see Display assembly on page 45)

Base enclosure (see Base enclosure on page 50)

58 Chapter 4 Removal and replacement procedures



Remove the speaker:
1. Disconnect the speaker cable (1) from the system board.
2.  Remove the Phillips PM2.0x9.0 screw (2) that secures the speaker to the top cover.

3. Remove the speaker (3).

Reverse this procedure to install the speaker.
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System board

Description Spare part number
For use only with computer models with Intel Core processors and WLAN capability 448339001
For use only with computer models with Intel Celeron M processors and WLAN capability 448337-001
For use only with computer models without WLAN capability 448338-001

When replacing the system board, be sure that the following components are removed from the defective
system board and installed on the replacement system board:

Memory module (see Memory module on page 35)

WILAN module (see WLAN module on page 37)

RTC battery (see RTC battery on page 52)

Processor (see Processor on page 57)

PC Card assembly (see PC Card assembly on page 62)

Before removing the system board, follow these steps:

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 31).

Remove the following components:

a. Hard drive (see Hard drive on page 32)

b. Memory/WLAN module compartment cover (see Memory module on page 35)

c. Optical drive (see Optical drive on page 39)

d. Switch cover (see Switch cover on page 41)

e. Keyboard (see Keyboard on page 43)

f. Display assembly (see Display assembly on page 45)

d. Base enclosure (see Base enclosure on page 50)

h. Fan assembly (see Fan assembly on page 53)

i.  Heat sink (see Heat sink on page 55)
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Remove the system board:

1. Remove the Phillips PM2.0x3.0 screw that secures the system board to the top cover .

2. Use the optical drive connector (1) to lift the left side of the system board (2) until it rests at an angle.

3.  Flex the right side of the top cover (3) until the external monitor connector clears the opening in the
top cover.

4. Slide the system board (4) away from the top cover at an angle until it clears the top cover

0‘

Reverse this procedures to install the system board.
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PC Card assembly

Description Spare part number
PC Card assembly 438551001
PC Card slot bezel 438527-001

Before removing the PC Card assembly, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 31).

Remove the following components:

a.

b.

je

Hard drive (see Hard drive on page 32)

Memory/WLAN module compartment cover (see Memory module on page 35)

Optical drive (see Optical drive on page 39)

Switch cover (see Switch cover on page 41)

Keyboard (see Keyboard on page 43)

Display assembly (see Display assembly on page 45)

Base enclosure (see Base enclosure on page 50)

Fan assembly (see Fan assembly on page 53)

Heat sink (see Heat sink on page 55)

System board (see System board on page 60)

Remove the PC Card assembly:

1.

Position the system board with the PC Card eject button toward you.

62 Chapter 4 Removal and replacement procedures



2. Remove the two Phillips PM2.0x7.0 screws (1) and two Phillips PM2.0x4.0 screws (2) that secure
the PC Card assembly to the system board.

3. Turn the system board top-side up, with the PC Card eject button toward you.
4. Disengage the slots on the PC Card assembly from the tabs (1) on the PC Card connector.

5. Remove the PC Card assembly (2) from the system board.

Reverse this procedure to install the PC Card assembly.
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TouchPad cable

Description

Spare part number

TouchPad cable 438562001

Before removing the TouchPad cable, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 31).

Remove the following components:

a.

b.

je

Hard drive (see Hard drive on page 32)

Memory/WLAN module compartment cover (see Memory module on page 35)

Optical drive (see Optical drive on page 39)

Switch cover (see Switch cover on page 41)

Keyboard (see Keyboard on page 43)

Display assembly (see Display assembly on page 45)

Base enclosure (see Base enclosure on page 50)

Fan assembly (see Fan assembly on page 53)

Heat sink (see Heat sink on page 55)

System board (see System board on page 60)

Remove the TouchPad cable:

1.

Position the top cover with the front toward you.
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2. Release the ZIF connector (1) to which the TouchPad cable is connected, and disconnect the
TouchPad cable (2) from the TouchPad board.

Reverse this procedure to install the TouchPad cable.
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9 Computer Setup

Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system is
not working or will not load.

Y NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: Pointing devices are not supported in Computer Setup. You must use the keyboard to navigate
and make selections.

NOTE: An external keyboard connected by USB can be used with Computer Setup only if USB legacy
support is enabled.

To start Computer Setup:
1. Turn on or restart the computer.

2. Before Windows® opens and while the "F10 = ROM Based Setup" message is displayed in the
lower-left corner of the screen, press f10.
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Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.

1. Open Computer Setup by turning on or restarting the computer, and then pressing 10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

Because Computer Setup is not Windows-based, it does not support the TouchPad. Navigation and
selection are by keystroke:

e To choose a menu or a menu item, use the arrow keys.
e To select an item, press enter.
e To close open dialog boxes and return to the main Computer Setup screen, press esc.
e To view navigation information, press f1.
e To change the language, press 2.
2. Select the File, Security, Diagnostics, or System Configuration menu.
3. To exit Computer Setup, choose one of the following methods:

e  To exit Computer Setup without saving your preferences, use the arrow keys to select File >
Ignore Changes and Exit. Then follow the instructions on the screen.

e To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes and Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

Restoring factory settings in Computer Setup
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Open Computer Setup by turning on or restarting the computer, and then pressing 10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select File > Restore defaults, and then press enter.
3. When the confirmation dialog box opens, press f10.

4. To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes and Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

Ef NOTE: Your password settings and security seftings are not changed when you restore the factory
settings.
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Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

Ef NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your

computer.

File menu

Select

To do this

System information

e  View identification information for the computer and the batteries in the system.

e  View specification information for the processor, cache and memory size, system ROM,
video revision, and keyboard controller version.

Restore defaults

Replace the configuration settings in Computer Setup with the original factory settings.
(Password settings and security settings are not changed when you restore the factory settings.)

Ignore changes and exit

Cancel any changes entered during the current session. Then exit and restart the computer.

Save changes and exit

Save any changes entered during the current session. Then exit and restart the computer. Your
changes go into effect when the computer restarts.

Computer Setup menus 69



Security menu

Select

To do this

Setup password

Enter, change, or delete a setup password.

Power-On password

Enter, change, or delete a power-on password.

Password options

e  Enable/disable stringent security.

e  Enable/disable password requirement on computer restart.

Drivelock passwords

e  Enable/disable Drivelock on any computer hard drive and on optional MultiBay hard
drives.

e  Change a Drivelock user password or master password.

NOTE: Drivelock settings are accessible only when you enter Computer Setup by turning on
(not restarting) the computer.

Smart Card security

Enable/disable support for smart card and Java™ Card power-on authentication.

NOTE: Power-on authentication for smart cards is supported only on computers with optional
smart card readers.

NOTE: You must have an administrator password to change this sefting.

TPM Embedded Security

Enable/disable support for Trusted Platform Module (TPM) Embedded Security, which protects
the computer from unauthorized access to owner functions available in Embedded Security for
ProtectTools. For more information, refer to the ProtectTools software Help.

NOTE: You must have a setup password to change this sefting.

System IDs

Enter user-defined computer asset fracking number and ownership tag.

Disk Sanitizer

Run Disk Sanitizer to destroy all existing data on the primary hard drive. The following options
are available:

e  Fast: Runs the Disk Sanitizer erase cycle once.
e  Optimum: Runs the Disk Sanitizer erase cycle 3 times.
e  Custom: Allows you to select the desired number of Disk Sanitizer erase cycles from a list.

CAUTION: If you run Disk Sanitizer, the data on the primary hard drive is destroyed
permanently.

Diagnostics menu

Select

To do this

Hard Drive Self-Test options

Run a comprehensive selftest on any hard drive in the system or on any optional MultiBay hard
drive.

Memory Check

Run a comprehensive check on system memory.

Startup Check (select models
only)

Verify the system components needed for starting the computer.
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System Configuration menu

Ef NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select

To do this

Language (or press 2)

Change the Computer Setup language.

Boot options

Set {9, 110, and {12 delay when starting up.

Enable/disable CD-ROM boot.

Enable/disable floppy boot.

Enable/disable internal network adapter boot and set the boot mode (PXE or RPL).

Enable/disable MultiBoot, which sets a boot order that can include most boot devices in
the system.

Set the Express Boot Popup delay in seconds.

Set the boot order.

Device configurations

Swap the functions of the fn key and left ctrl key.

Enable/disable multiple standard pointing devices at startup. (To set the computer to
support only a single, usually nonstandard, pointing device at startup, select Disable.)

Enable/disable USB legacy support. When enabled, USB legacy support allows the
following:

o Use of a USB keyboard, mouse, and hub in Computer Setup even when a Windows
operating system is not running.

o Startup from bootable USB devices, including a hard drive, diskette drive, or optical
drive connected by a USB port to the computer or to an optional docking device

(select models only).

Select a parallel port mode: EPP (Enhanced Parallel Port), standard, bidirectional, or ECP
(Enhanced Capabilities Port).

Enable/disable BIOS DMA data transfers.
Enable/disable fan always on while connected to an AC outlet.

Enable/disable Intel® Data Execution Prevention or AMD® PSAE Execution Disable.
When enabled, the processor can disable some virus code execution, which helps to
improve computer security.

Enable/disable LAN Power Save. When enabled, saves power by turning off the LAN
when not in use.

Enable/disable SATA Native Mode.

Enable/disable Dual Core CPU.

Enable/disable Secondary Battery Fast Charge.
Choose Bit-shift or LBA assisted HDD Translation Mode.
Enable/disable Windows direct application launcher.

Enable/disable HP Lockout.

Builtln Device Options

Enable/disable embedded WWAN Device Radio.

Enable/disable embedded WLAN Device Radio.
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Select

To do this

Enable/disable embedded Bluetooth® Device Radio.

Enable/disable LAN/WLAN Switching. When enabled, switches to a WLAN when a
LAN is either unavailable or disconnected.

Enable/disable Wake on LAN from Off.

Enable/disable the ambient light sensor.

Port Options

Enable/disable the serial port.
Enable/disable the parallel port.
Enable/disable the flash media reader.
Enable/disable the USB port.

CAUTION: Disabling the USB port also disables MultiBay devices and ExpressCard
devices on the advanced port replicator.

Enable/disable the 1394 port.
Enable/disable the cardbus slot.
Enable/disable the ExpressCard slot.
Enable/disable the infrared port.
Enable/disable the optical disk drive.

Enable/disable the network controller.
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6 Specifications

Computer specifications

Metric u.s.
Dimensions
Height (front to back) 3.01103.41 cm 1.181t0 1.34 in
Width 33.39 cm 13.19in
Depth 24.68 cm 9.75in
Weight (with optical drive, hard drive, and battery) 2.48 kg 5.47 lbs
Input power
Operating voltage 185Vdc@35A-65W
Operating current 35A
Temperature
Operating (not writing to optical disc) 0°Cto 35°C 32°F to 95°F
Operating (writing to optical disc) 5°Cto 35°C 41°F to 95°F
Nonoperating -20°C to 60°C -4°F to 140°F
Relative humidity
Operating 10% to 90%
Nonoperating 5% to 95%
Maximum altitude (unpressurized)
Operating (14.7 to 10.1 psia) -15 m to 3,048 m -50 ft to 10,000 ft
Nonoperating (14.7 to 4.4 psia) -15mt0 12,192 m -50 ft to 40,000 ft
Shock
Operating 125 g, 2 ms, half-sine
Nonoperating 200 g, 2 ms, halfsine
Random vibration
Operating 0.75 g zero+to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate
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Metric u.s.

Nonoperating 1.50 g zeroto-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this
range of temperatures.

14.1-inch, WXGA display specifications

Metric u.s.
Dimensions
Height 21.4 cm 8.4in
Width 28.6 cm 11.21in
Diagonal 35.7 ecm 14.1in
Number of colors Up to 16.8 million
Contrast ratio 300:1 (typical)
Brightness 200 nits (typical)
Pixel resolution
Pitch 0.237 x 0.237 mm
Format 1024 x 768
Configuration RGB stripe
Backlight CCFL
Refresh rate 60 Hz
PPI 107
Viewing angle +/-45° horizontal, +/-25° vertical (typical)
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Hard drive specifications

120-GB* 80-GB*
Dimensions
Height 9.5 mm 9.5 mm
Width 70 mm 70 mm
Weight 101 g 101 g
Interface type ATA-7 ATA-7
Transfer rate
Synchronous (maximum) 100 MB/sec 100 MB/sec
Security ATA security ATA security
Seek times (typical read, including setting)
Single track 3ms 3 ms
Average 13 ms 13 ms
Maximum 24 ms 24 ms
Logical blocks 234,420,480 156,280,320
Disc rotational speed 5400 rpm 5400 rpm
Operating temperature 5°Cto 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.

NOTE: Cerfain restrictions and exclusions apply. Consult technical support for defails.
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Primary 4-cell, Li-ion battery specifications

Metric u.s.
Dimensions
Height 2.00 cm 0.79 in
Width 26.80 cm 3.70in
Depth 5.30 cm 5.28 in
Weight 0.34 kg 0.751b
Energy
Voltage 14.4V
Amp-hour capacity 4.8 Ah
Woatt-hour capacity 69 Wh
Temperature
Operating 5°Cto 45°C 41°F to 113°F
Nonoperating 0°Cto 60°C 32°F to 140°F
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DVD*=RW and CD-RW Super-Multi Double-Layer
Combo Drive specifications

Applicable disc

Read: Write:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD- CD-R and CD-RW

ROM, CD-ROM XA, MIXED MODE CD, CD,
CD-l Bridge (Photo-CD, Video CD),
Multisession CD (Photo-CD, CD-EXTRA, RAM
Portfolio, CD-R, CD-RW), CDR, CD-RW, DVD-

ROM (DVD-5, DVD-9, DVD-10, DVD-18), DVD-

R, DVDRW, DVD+R, DVD+RW, DVDRAM

DVD+R, DVD+RW, DVD-R, DVD-RW, DVD-

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc 12 cm (4.72 in)

Mini disc 8 cm (3.15in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 um

Access time cD DVD
Random <175 ms <230 ms
Full stroke <285 ms <335 ms

Audio output level

Audio-out, 0.7 Vrms

Cache buffer

2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec
8X DVD 10,800 KB/sec
24X CDR 3,600 KB/sec
16X CD-RW 2,400 KB/sec
8X DVD+R 10,800 KB/sec
4X DVD+RW 5,400 KB/sec
8X DVD-R 10,800 KB/sec
4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9)

2,700 KB/sec

5X DVD-RAM

6,750 KB/sec

Transfer mode

Multiword DMA Mode

Startup time

< 15 seconds

Stop time

< 6 seconds

DVD+RW and CD-RW Super-Multi Double-Layer Combo Drive specifications
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DVD/CD-RW Combo Drive specifications

Applicable disc

Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-
ROM, CD-ROM XA, MIXED MODE CD, CD,
CD-l Bridge (Photo-CD, Video CD),
Multisession CD (Photo-CD, CD-EXTRA,

Portfolio, CD-R, CD-RW), CD-R, CD-RW, DVD-
ROM (DVD-5, DVD-9, DVD-10, DVD-18), DVD-

R, DVDRW, DVD+R, DVD+RW, DVD-RAM

Write:

CD-R and CD-RW

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc 12 cm (4.72 in)

Mini disc 8 cm (3.15in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 um

Access time cD DVD
Random <110 ms <130 ms
Full stroke <210 ms <225 ms

Audio output level

Line-out, 0.7 Vrms

Cache buffer

2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec
8X DVD 10,800 KB/sec
24X CD-R 3,600 KB/sec
24X CD-RW 3,600 KB/sec

Transfer mode

Multiword DMA mode 2

Startup time

< 15 seconds

Stop time

< 6 seconds
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System DMA specifications

Hardware DMA

System function

DMAO Not applicable

DMAT1* Not applicable

DMA2* Not applicable

DMA3 Not applicable

DMA4 Direct memory access controller
DMAS5* Available for PC Card

DMA6 Not assigned

DMA7 Not assigned

*PC Card controller can use DMA 1, 2, or 5.

System DMA specifications
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System interrupt specifications

Hardware IRQ System function

IRQO System timer

IRQ1 Standard 101-/102-Key or Microsoft Natural Keyboard

IRQ2 Cascaded

IRQ3 Intel 82801DB/DBM USB2 Enhanced Host Controller—24CD

IRQ4 COMI

IRQ5* Conexant AC—Link Audio Intel 82801DB/DBM SMBus Controller—24C3 Data
Fax Modem with SmartCP

IRQ6 Diskette drive

IRQ7* Parallel port

IRQ8 System CMOS/real4ime clock

IRQ9* Microsoft ACPl-compliant system

IRQ10* Intel USB UHCI controller—24C2

Intel 82852/82855 GM/GME Graphic Controller

Realtek RTL8139 Family PCl fast Ethernet Controller

RQ11 Intel USB EHCI controller—24CD
Intel USB UHCI controller—24C4
Intel USB UHCI controller—24C7
Intel Pro/Wireless 2200BG
TI OHCI 1394 host controller

TI PCI1410 CardBus controller

IRQ12 Synaptics PS/2 TouchPad
IRQ13 Numeric data processor
IRQ14 Primary IDE channel
IRQ15 Secondary IDE channel

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQY, IRQ10, or none.

NOTE: PC Cards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQY, IRQ10, IRQ11, or IRQ15. Either the infrared or the serial port
may assert RQ3 or IRQ4.
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System I/O address specifications

1/0 address (hex) System function (shipping configuration)
000 - OOF DMA controller no. 1

010-01F Unused

020 - 021 Interrupt controller no. 1

022-024 Opti chipset configuration registers
025 - O3F Unused

02E - 02F 87334 “Super |/O" configuration for CPU
040 - 05F Counter/timer registers

044 - 05F Unused

060 Keyboard controller

061 Port B

062 -063 Unused

064 Keyboard controller

065 - 06F Unused

070-071 NMI enable/RTC

072 - 07F Unused

080 - 08F DMA page registers

090 - 091 Unused

092 Port A

093 - 09F Unused

0AO - OA1 Interrupt controller no. 2

I/O Address (hex) System Function (shipping configuration)
OAZ2 - OBF Unused

0CO - ODF DMA controller no. 2

OEO - OEF Unused

OF0 - OF1 Coprocessor busy clear/reset

OF2 - OFF Unused

100 - 16F Unused

170-177 Secondary fixed disk controller
178 - 1EF Unused

1FO - 1F7 Primary fixed disk controller

1F8 - 200 Unused

201 JoyStick (decoded in ESS1688)
202 - 21F Unused
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1/0 address (hex) System function (shipping configuration)

220 - 22F Entertainment audio

230- 26D Unused

26E - 26 Unused

278 - 27F Unused

280 - 2AB Unused

2A0 - 2A7 Unused

2A8 - 2E7 Unused

2E8 - 2EF Reserved serial port

2F0 - 2F7 Unused

2F8 - 2FF Infrared port

300-31F Unused

320 - 36F Unused

370-377 Secondary diskette drive controller
378 -37F Parallel port (LPT1/default)

380- 387 Unused

388 -38B FM synthesizer—OPL3

38C- 3AF Unused

3BO - 3BB VGA

3BC - 3BF Reserved (parallel port/no EPP support)
3CO0 - 3DF VGA

3EO0 - 3E1 PC Card controller in CPU

3E2 - 3E3 Unused

3E8 - 3EF Internal modem

3F0 - 3F7 “A" diskette controller

3F8 - 3FF Serial port (COM1/default)

CF8 - CFB PCl configuration index register (PCIDIVO-1)
CFC - CFF PCl configuration data register (PCIDIVO-1)
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System memory map specifications

Size Memory address System function

640 KB 00000000-0009FFFF Base memory

128 KB 0OO0OAO0000-O00BFFFF Video memory

48 KB 000C0000-000CBFFF Video BIOS

160 KB 000C8000-000E7FFF Unused

64 KB OOOE8000-000FFFFF System BIOS

15 MB 00100000-00FFFFFF Extended memory

58 MB 04800000-07FFFFFF Super extended memory
58 MB 04800000-07FFFFFF Unused

2 MB 08000000-080FFFFF Video memory (direct access)
4GB 08200000-FFFEFFFF Unused

64 KB FFFFOOOO-FFFFFFFF System BIOS
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Screw listing

This section provides specification and reference information for the screws and screw locks used in the
computer. All screws and screw locks listed in this section are available in the Screw Kit, spare part number

438558-001, and the Display Screw Kit, spare part number 438543-001.
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Phillips PM2.5x8.0 captive screw

® [Fm

I nm

Color Quantity Length Thread Head width

Black 3 8.0 mm 2.5 mm 5.0 mm

Where used:

(1) Two screws that secure the hard drive cover to the computer (screws are captured on the cover by C
clips)

(2) One screw that secures the memory/WLAN module compartment cover to the computer (screw is
captured on the cover by a C clip)
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Phillips PM3.0x3.0 screw

=® [m

mm bbbl

Color Quantity Length Thread Head width
Silver 4 3.0 mm 3.0 mm 5.0 mm
3
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- -
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Where used: 4 screws that secure the hard drive bracket to the hard drive
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Phillips PM2.0x4.0 screw

@

mm bl

Color Quantity Length Thread Head diameter

Black 2 4.0 mm 2.0 mm 4.5 mm

Where used: 2 screws that secure the WLAN module to the system board
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Phillips PM2.0x9.0 screw

SJON-
mm [l

Color Quantity Length Thread Head width

Black 20 9.0 mm 2.0 mm 5.0 mm

: I

Where used:
(1) One screw that secures the optical drive to the computer
(2) Five screws that secure the switch cover to the computer

(3) Two screws that secure the keyboard to the computer
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Where used: 2 screws that secure the display assembly to the computer

Where used: One screw that secures the base enclosure to the computer

Where used: 7 screws that secure the base enclosure to the computer
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Where used:
(1) One screw that secures the fan assembly to the computer

(2) One screw that secures the speaker to the computer
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Phillips PM2.0x3.0 screw

92

“@® b

mm [t

Color Quantity Length Thread Head width

Silver 9 3.0 mm 2.0 mm 4.5 mm

Where used: 4 screws that secure the display hinges to the display panel
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Where used: 2 screws that secure the PC Card assembly to the system board
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Phillips PM2.0x7.0 screw

@ [

mm ool

Color Quantity Length Thread Head width

Black 2 7.0 mm 2.0 mm 5.0 mm

Where used: 2 screws that secure the display assembly to the computer
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Phillips PM2.5%x6.0 screw

—® [

mm bbbl

Color Quantity Length Thread Head width

Silver 17 6.0 mm 2.5 mm 5.0 mm

Where used: One screw that secures the display inverter to the display enclosure
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Where used: 4 screws that secure the display panel to the display enclosure
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8 Backup and recovery

Creating recovery discs

After setting up the computer for the first time, be sure to create a set of recovery discs of the full factory
image. The recovery discs are used to start up (boot) the computer and recover the operating system and
software to factory settings in case of system instability or failure.

Note the following guidelines before creating recovery discs:

You will need high-quality CDR, DVD-R, or DVD+R discs (purchased separately).

B NOTE: Read-write discs, such as CD-RW and DVD+RW discs, are not compatible with HP Backup

& Recovery Manager.

The computer must be connected to AC power during the process.
Only one set of the recovery discs can be created per computer.
Number each disc before inserting it into the optical drive of the computer.

If necessary, you can cancel the disc creation before you have finished creating the recovery discs.
The next time you select Create a set of recovery discs (Recommended), you will be
prompted to continue the disc creation.

To create a set of recovery discs:

1.

Select Start > All Programs > HP Backup & Recovery > Backup & Recovery
Manager.

Click Next.
Click Create a set of recovery discs (Recommended), and then click Next.

Follow the on-screen instructions.
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Backing up your information

B NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup & Recovery Manager to create an entire drive backup as soon as you set up your computer.

With HP Backup & Recovery Manager, you can perform the following tasks:
e  Backing up your information regularly to protect your important system files

e  Creating system recovery points that allow you to reverse undesireable changes to your computer
by restoring the computer to an earlier state

e  Scheduling backups at specific intervals or events

When to back up

e  On a regularly scheduled basis

B’ NOTE: Set reminders to back up your information periodically.

e  Before the computer is repaired or restored

e  Before you add or modify hardware or software

Backup suggestions
e Create a set of recovery discs using HP Backup & Recovery Manager.

e  Create system recovery points using HP Backup & Recovery Manager, and periodically copy them
to disc.

e  Store personal files in the Documents folder and back up these folders periodically.
e  Back up templates stored in their associated programs.
e  Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your settings.
The screen shot can be a time saver if you have to reset your preferences.
To copy the screen and paste it into a word-processing document:
a. Display the screen.
b. Copy the screen.
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, and then select Edit > Paste.

B NOTE: Before you can perform Backup & Recovery procedures, the computer must be connected to
external power.

NOTE: Drivers, utilities, and applications installed by HP can be copied to a CD or to a DVD using HP
Backup & Recovery Manager.
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Backing up specific files or folders

You can back up specific files or folders to the recovery partition on the hard drive, to an optional external
hard drive, or to optical discs (CDs or DVDs).

NOTE: This process will take several minutes, depending on the file size and the speed of the computer.

To back up specific files or folders:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery
Manager.

2. Click Next.
3. Click Create or manage backups, and then click Next.
4. Click Back up user created files and folders, and then click Next.

5. Follow the on-screen instructions.

Backing up the entire hard drive

When you perform a complete backup of the hard drive, you are saving the full factory image, including
the Windows® operating system, software applications, and all personal files and folders.

NOTE: A copy of the entire hard drive image can be stored on another hard drive, on a network drive,
or on recovery discs that you create.

NOTE: This process may take over an hour, depending on your computer speed and the amount of
data being stored.

To back up your entire hard drive:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery
Manager.

2. Click Next.
3. Click Create or manage backups, and then click Next.
4. Click Create or manage Entire Drive Backups, and then click Next.

5. Follow the on-screen instructions.
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Creating recovery points

By

When you back up modifications since your last backup, you are creating system recovery points. This
allows you to save a snapshot of your hard drive at a specific point in time. You can then recover back
to that point if you want to reverse subsequent changes made to your system.

NOTE: The first system recovery point, a snapshot of the entire image, is automatically created the first
time you perform a backup. Subsequent recovery points make copies of changes made after that time.

HP recommends that you create recovery points at the following times:
e  Before you add or extensively modify software or hardware

e  Periodically, whenever the system is performing optimally

NOTE: Recovering to an earlier recovery point does not affect data files or e-mails created since that
recovery point.

To create a system recovery point:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery
Manager.

2. Click Next.
3. Click Create or manage backups, and then click Next.
4. Click Create or manage Recovery Points, and then click Next.

5. Follow the on-screen instructions.

Scheduling backups

Use HP Backup Scheduler to schedule backups for the entire system, for recovery points, or for specific
files and folders. With this tool, you can schedule backups at specific intervals (daily, weekly, or monthly)
or at specific events, such as at system restart or when you dock to an optional docking station (select
models only).

To schedule backups:
1. Select Start > All Programs > HP Backup & Recovery > HP Backup Scheduler.

2. Follow the on-screen instructions.
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Performing a recovery

B NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup & Recovery Manager to create an entire drive backup as soon as you set up your computer.

HP Backup & Recovery Manager helps you with the following tasks for safeguarding your information
and restoring it in case of a system failure:

e  Recovering important files—This feature helps you reinstall important files without performing a full
system recovery.

e  Performing a full system recovery—With HP Backup & Recovery Manager, you can recover your full
factory image if you experience system failure or instability. HP Backup & Recovery Manager works
from a dedicated recovery partition on the hard drive or from recovery discs you create.

Performing a recovery from the recovery discs
To perform a recovery from the recovery discs, follow these steps:
1. Back up all personal files.
2. Insert the first recovery disc into the optical drive and restart the computer.

3. Follow the on-screen instructions.

Performing a recovery from the hard drive
There are 2 ways to initiate a recovery from the hard drive:
e  From within Windows

e  From the recovery partition
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Initiating a recovery in Windows

To initiate a recovery in Windows, follow these steps:

1.
2.

3.
4.
5.

Back up all personal files.

Select Start > All Programs > HP Backup & Recovery > Backup & Recovery
Manager.

Click Next.
Click Perform a recovery, and then click Next.

Follow the on-screen instructions.

Initiating a recovery from the hard drive recovery partition

To initiate a recovery from the hard drive recovery partition, follow these steps:

1.
2.
3.

Back up all personal files.
Restart the computer, and then press f11 before the Windows operating system loads.
Click a recovery option, and then click Next.

Follow the on-screen instructions.
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9 Connector pin assignments

Audio-out (headphone)

-

Signal

Audio out, left channel

Audio out, right channel

Ground

-

1
Pin Signal
1 Audio signal in
2 Audio signal in
3 Ground

Audio-out (headphone) 103



External monitor

@O 006
®000
®0006

Pin Signal

1 Red analog

2 Green analog
3 Blue analog

4 Not connected
5 Ground

6 Ground analog
7 Ground analog
8 Ground analog
9 +5 VDC

10 Ground

11 Monitor detect
12 DDC 2B data
13 Horizontal sync
14 Vertical sync
15 DDC 2B clock
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RJ-11 (modem)

123456

Pin

Signal

Unused

1
2
3
4
5
6

[ [ [ A =
=] =) =)

c c

o o o

RJ-45 (network)

LT
12345678

Pin Signal

1 Transmit +
2 Transmit -
3 Receive +
4 Unused

5 Unused

6 Receive -
7 Unused

8 Unused
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Universal Serial Bus

1 2 3 4
I--_-_-.I

Pin Signal
1 +5 VDC
2 Data -
3 Data +
4 Ground
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10 Power cord set requirements

The wide range input feature of the computer permits it o operate from any line voltage from 100 to 120

or 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the country
where the equipment is purchased.

Power cord sets for use in other countries must meet the requirements of the country where the computer
is used.

Requirements for all countries

The requirements listed below are applicable to all countries.

The length of the power cord set must be at least 1.5 m (5.0 ft) and a maximum of 2.0 m (6.5 f).

All power cord sets must be approved by an acceptable accredited agency responsible for evaluation
in the country where the power cord set will be used.

The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage rating
of 125 or 250 V AC, as required by each country’s power system.

The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard
Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries

Country/region Accredited agency Applicable note number
Australia EANSW 1
Austria OVE 1
Belgium CEBC 1
Canada CSA 2
Denmark DEMKO 1
Finland FIMKO 1
France UTE 1
Germany VDE 1
ltaly IMQ 1
Japan METI 3
Korea EK 4
The Netherlands KEMA 1
Norway NEMKO 1
The People's Republic of China CCC 5
Sweden SEMKO 1
Switzerland SEV 1
Taiwan BSMI 4
The United Kingdom BSI 1
The United States uL 2
1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0 mm2 conductor size. Power cord set fittings (appliance coupler

and wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it will be used.

The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding
type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00 mm? conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

The flexible cord must be Type RVV, 3-conductor, 0.75 mm?2 conductor size. Power cord set fittings (appliance coupler and
wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it will be used.

The flexible cord must be Type VCTF, 3-conductor, 0.75 mm? conductor size. Power cord set fittings (appliance coupler and
wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it will be used.
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11 Recycling

Battery

When a battery has reached the end of its useful life, do not dispose of the battery in general household
waste. Follow the local laws and regulations in your area for computer battery disposal.

Display

A WARNING! The backlight contains mercury. Caution should be exercised when removing and
handling the backlight to avoid damaging this component and causing exposure to the mercury.

A CAUTION: The procedures in this appendix can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the backlight.
Careful handling should be exercised when removing these components.

B NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly
that might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities or the
Electronic Industries Alliance (EIA) at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

9 —-

B NOTE: Disassembly procedures differ from one display assembly to another. The procedures provided
in this appendix are general disassembly instructions. Specific details, such as screw sizes, quantities,
and locations, and component shapes and sizes, can vary from one computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of the
display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

Remove all screws (1) that secure the display panel assembly to the display enclosure.

Remove the display panel assembly (2) from the display enclosure.

Turn the display panel assembly upside down.

Remove all screws that secure the display panel frame to the display panel.

Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it forward.

o

u
o\

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

17. Remove the backlight frame from the display panel.

A WARNING! The backlight contains mercury. Caution should be exercised when removing and
handling the backlight to avoid damaging this component and causing exposure to the mercury.

Display 113



18. Slide the backlight out of the backlight frame.

19. Disconnect the display cable (1) from the LCD panel.
20. Remove the screws (2) that secure the LCD panel to the display rear panel.
21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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